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End User License Agreement (EULA)

Use of this product is subject to the acceptance of our End User License Agreement, available here.

©2022 UVI. All rights reserved.
All trademarks are the property of their respective owners.

http://www.uvi.net/
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Introduction

SATURN-4

The first under the moniker and the first 
self-contained polyphonic synth under the 
brand, this synth is a 4-voice poly from 
1978. The voices can be synced to create a 
meaty 4-osc monophonic sound and has 
been famously used by acts such as the 
Cars, Duran Duran, Simple Minds, Vangelis 
and Meat Beat Manifesto. For this synth 
we deeply-sampled the oscillator section 
to replicate the hardware use as closely as 
possible with samples. Every position of the 
oscillator section was multisampled, and 
every sound in the library was captured 
with and without the hardware unison 
and hardware ensemble effect providing 
an incredibly rich and authentic sound.

SATURN-6

A true vintage gem, this 12-oscillator, 
6-voice analog polysynth can create 
massively thick sounds - a pad and drone 
dream machine. Debuting in 1983 this 
instrument has been famously used by 
The Prodigy, Crystal Method, Chemical 
Brothers, Devo, Tangerine Dream, Human 
League and Orbital among others. A 
comprehensive sampling provides two 
unison settings for all presets allowing you 
to create a wide variety of sounds from 
modulating drones to ripping basses.

SATURN-8

One of the most iconic analog synthesizers 
ever produced, and the brands flagship, 
this featured synth sports 16-oscillators 
on 8-voices with cross-modulation, 
sync, PWM, an HPF, variable LPF, an LFO 
and two EGs. An incredible polyphonic 
unison mode allows all 16 oscillators 
to be stacked on a single note! We 
captured everything, with and without the 
hardware unison, giving you an incredible 
catalog of powerful analog sounds.

MERCURY-80

The expanded rackmount brother of 
our Saturn-6, this 16-oscillator 8-voice 
super-synth came equipped with fully-
analog VCOs and a low boost circuit. 
Able to replicate many sounds of its 
keyboard counterpart, this synth wasn’t 
simply a rackmount adaptation but a 
unique instrument with its own character 
and strengths. Due to its friendly form 
factor these were in high demand in the 
day, popular on tours but equally potent 
in the studio, used extensively by acts 
like Tangerine Dream, Herbie Hancock, 
Vangelis, John Carpenter, Talk Talk, and 
Madonna. We captured every sound with 
and without the hardware unison and 
captured many unique and inspiring tones.

JP Legacy
Galactic Japanese Analog Synth Suite

• 4 instruments explore the sounds of an iconic Japanese moniker

• 800+ presets deliver the authentic analog sounds of real hardware

• Rich and charactered sounds, customizable sample-based instruments

One of the most iconic names in the synth world gets the UVI treatment! These 

instruments need no introduction, hen’s tooth synths from the peak of the analog age 

some fetching upwards of $15,000+ at auction. We’ve taken 4 of our favorite instruments 

from this lineage, serviced them and made a deep-dive into sound design - creating 

a massive collection of 827 new patches putting all the analog mojo of these synths 

right into your DAW with the consistent quality you’ve come to expect from UVI.

With JP Legacy you have unprecedented access to the actual hardware sounds of these 

instruments, no emulations here. Every sound was deeply multisampled, multiple times, 

giving you access to features like hardware unison and ensemble at the press of a button. 

A rich and authentic sound bristling with the warmth of vintage hardware, JP Legacy 

represents hundreds of hours of expertly-crafted sounds totalling 827 presets built on 

85,540 samples delivering professional hardware results with software ease-of-use.

All sounds in JP Legacy are fully editable and come neatly wrapped in hardware-

inspired interfaces, giving you the real feel of the synths as you tweak and perform. 

Included presets cover the full gamut of types and styles, including plenty of bread and 

butter patches, vintage classics and modern staples. Quickly browse through categories, 

audition presets, then edit, layer and even completely transform sounds to suit your 

needs, all with the genuine warmth, character and grit of real analog circuits.

Roland, Jupiter 4, Jupter 6, Jupiter 8 and MKS80 are trademarks of their respective 

owners. UVI is not affiliated or endorsed by any entities listed here.

Minimum System Requirements

• Lates version of UVI Workstation or Falcon

• 34.51GB of disk space

For more information on the installation process, please refer to 

the document: Soundbank Installation Guide

http://www.uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
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SATURN-4 - Main Page and Globals

OSC-1

Filter

5

8

Balance4
Edit Layer 3

OSC-2 6

Amplitude 7

Master Volume 2

Pages 1

1  Pages
» Main, Edit, Modulation, Effects and 

 Arpeggiators

Click to change the current control page

2  Master Volume

3  Edit Layer
» Select: OSC-1 / OSC-2 / 1+2

Select OSC-1, OSC-2 or both (1+2) ; 

presents discrete Signal, Unison, Amp 

Env, Filter and Filter Env controls

» Unison

Enables genuine hardware unison per 

layer

» Ensemble

Enables genuine hardware ensemble 

effect per layer

4  Balance
Sets the balance between low and high 

register of the keyboard

5  OSC-1
» Power : Turn OSC-1 on/off

» Volume : Adjust OSC-1 volume

» Pan : Adjust OSC-1 pan

» Range : Select the base pitch range of 

OSC-1

» Sub : Turn sub-oscillator on/off

» PW : Sets the pulse width modulation 

mode for pulse width waveform

LFO in MOD page will affect PWM in 

MOD mode

Select 1, 2 and 3 for manual PWM mode

» Waveform : Sets OSC-1 waveform

» Noise : Turn the noise generator on/off, 

and sets the volume

6  OSC-2
» Power : Turn OSC-2 on/off

» Volume : Adjust OSC-2 volume

» Pan : Adjust OSC-2 pan

» Sounds : Select the programed OSC 

sound

5  Amplitude
» Velocity

Toggle velocity on/off

» Vel > Atk

When active, routes Velocity input to 

Amp Env: Attack

» ADSR

Adjust the amplitude using a typical 

Attack, Decay, Sustain, Release envelope

6  Filter
» Mode

Select between LP, BP or HP filter 

shapes, or OFF to disable the filter

» Frequency

Set the filter cutoff frequency

» Resonance

Set the filter resonance amount

» Depth

Set the filter’s depth amount

» Velocity

Set the filter’s velocity sensitivity

» ADSR

Typical ADSR envelope for the Filter 

Saturn-4 is outfitted with 2 layers; OSC-1 and OSC-2. OSC-1 has three waveforms plus a noise generator and OSC-2 has a selection of 18 sounds. Both layers 
have dedicated volume, pan, filters and envelope generators for amplitude and filter, and arpeggiators in the Arpeggiator page. Edit and Effects pages affect 
the summed signal of both layers while Modulation can be set to selectively target OSC-1 and/or OSC-2.

http://www.uvi.net/
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SATURN-4 - Edit Page

Edit Layer

Voicing

Pitch3

Stereo4

Modwheel5

1

2

1  Edit Layer
Select OSC-1, OSC-2 or both (1+2) ; 

presents discrete controls for Pitch/

Portamento, Stereo and Modwheel

2  Voicing
» Mode

Toggle between Mono and Poly voicing

» Time

Set the Glide time

» Depth

Adjust the Portamento depth

3  Pitch
» Octave

Adjust the pitch in Octaves

» Semitone

Adjust the pitch in Semitones

4  Stereo
» Mode

Off / Alternate Pan / Unison

» Spread

Change the stereo width

» Detune

Unison layer detune amount 

[Unison mode only]

» Color

Shifts color based on adjacent samples

5  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato Rate, Tremolo Rate and Filter 

Depth

http://www.uvi.net/
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SATURN-4 - Modulation Page

Step Modulator 1

1  Step Modulator
» Steps

Change the number of playable steps 

(1-16)

» Editor

Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

» Speed

Change the step duration (1/32 - 1/1)

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Average

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

» Step Modulator Target

Control the amounts of modulation to be 

applied to each or both layer’s Volume 

Amount, and Filter Depth

2  LFO
» Speed

Change the LFO Speed

» Sync

Enable/Disable LFO sync to Host Tempo

» Waveshape

Choose LFO waveshape; Sine, Triangle, 

Square or Sample & Hold

» LFO Routing

Control the amount of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

» Mode

Change the LFO retrigger mode; 

Retrigger, No Retrigger or Legato

» LFO Target

Control the amount of modulation to be 

applied to each or both layer’s Volume 

Amount, Filter and Pitch Depth

3  Modulation Targets
Set the target oscillator for the 

parameter modulation, Upper and/or 

Lower layer

Modulation Targets3

LFO2

http://www.uvi.net/
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SATURN-4 - Effects Page

1  Equalizer
» On/Off

Turn the effect on/off

» Gain Low / Mid / High

Adjust the gain boost or cut amount of 

each frequency band

» Frequency

Set the crossover frequency point of 

Low/Mid or Mid/High band

2  Drive
» On/Off

Turn the effect on/off

» Amount 

 Adjust the drive amount

3  Thorus
» On/Off

Turn the effect on/off

» Speed 

 Adjust the chorus modulation speed

» Depth 

 Adjust the chorus modulation depth

4  Ensemble
» On/Off

Turn the effect on/off

» Mode 

 Set the ensemble effect mode

» Tone 

 Adjust the brightness of the effect

» Mix 

 Adjust the effect mix amount

5  Phasor
» On/Off

Turn the effect on/off

» Speed 

 Adjust the phaser modulation speed

» Feedback 

 Adjust the phaser feedback amount

» Depth 

 Adjust the phaser modulation depth

6  Delay
» On/Off

Turn the effect on/off

» Time 

 Adjust the delay time

» Feedback 

 Adjust the delay feedback amount

» LoCut 

 Adjust the delay output’s low-cut filter  

 frequency

» HiCut 

 Adjust the delay output’s hi-cut filter   

 frequency

» Mix 

 Adjust the delay effect mix amount

7  Sparkverb
» On/Off

Turn the effect on/off

» Size 

 Adjust the reverb room size

» Decay 

 Adjust the reverb decay time

» Decay: Lo Freq 

 Multiplies the decay time (-/+) for the  

 low frequency signal

» Decay: Hi Freq 

 Multiplies the decay time (-/+) for the  

 high frequency signal

» Mix 

 Adjust the reverb mix amount

Equalizer 1

Phaser 5

Thorus 3

Sparkverb 7

Delay6

Ensemble4

Drive2

http://www.uvi.net/
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SATURN-4 - Arpeggiator Page

Steps

Link

Speed

Arp On/Off

Gate

Octave

Mode

Step Indicator4

Step Editor5

Tie6

9

10

2

7

3

8

1

1  Power
Toggle the Arpeggiator On/Off

2  Mode
Select Up, Down, or Up and Down

3  Link
Switch to link the two arpeggiators

4  Step Indicator
LED lights up when step is triggered

5  Step Editor
Freely draw note velocities

6  Tie
When active, step inherits Velocity from 

the previous step

7  Steps
Change the number of playable steps 

(1-16)

8  Speed
Change the step duration (1/32 - 1/1)

9  Gate
Change the step length (from zero to the 

tracks Resolution setting)

10  Octave
Set the pitch range in Octaves

http://www.uvi.net/
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SATURN-4 - Preset List

00-S4 Init Mono
00-S4 Init Real Uni Ens
00-S4 Init Unison

01-Saturn 4 Internals
01 Bass
02 String
03 Funky Clav
04 Piano
05 Voice
06 Trombone
07 Sax

08 Trumpet
09 Synth
10 The Force
CP1 Synt Bell
CP2 Hybrid Bell
CP3 Smooth Keys
CP4 Soft Brass
CP5 Electric Organ
CP6 Harpsichord
CP7 Synth Pad
CP8 Orchestral

Animated Arp
Arp And Stack
Depeche Mod
Duorarpal 1
Duorarpal 2
Happy Gator
HH n BD 1
HH n BD 2
Jump Journey
Modular Four 1
Modular Four 2
Monoarpal 1
Monoarpal 2
Noise A Rus
One Key Wheel
Padsandarpege
Parmesan
Pop Bass Corn
Porte El Manteau
Saturno
Seq Bass Tanger
Solo Morphweel
Sub Orbit 1
Sub Orbit 2
Symphony Of Arp
Tangerine Wheel

Animated Step
Arp Step Battle
Doors Of Jupiter
Egrainage
Four Analog
Hyper Space
LA Pression
Pattern Poly

Pop Corning
Sound Check
Step Harper
Subtle Bass Melody
Unatural

Bass
Bass Ensemble
Clic Bass
Fat Saw
Filter Mass
Frantik Tok
Lil Drive
Mono Step
Noisub
Orange Shaft
Phase Grain
S4 Bass Seq 1
S4 Bass Seq 2
S4 Bass Seq 3
S4 Bass Seq 4
S4 Bass Seq 5
S4 Bass Seq 6
S4 Bass Seq 7
Saturna SID
Siberian Night
Sub N Seq

Bells
Analog JP4 Bells
Long Anissa
Mysteriosity
Octave Noise
PWM Phase Bells
The Last Bell
Voice Mix

Brass
Fast Section 1
Fast Section 2
Fire Brass
Orchesbrass
Portame
S Four Horns
Space Saxophone
Trumpets Noise
Vangelarp

Keys
Harpsi Space
HP Clav
Keys Pad
Old Age
Organ Spirit
Piano Mood
Pipes Orbit
Real Analog Piano
Smooth Tremo Keys
Space Cheez
Synth Organ
Ultra Clav
Wet Wheel Keys

Leads
5th Lead
Funky Saw
Hook Wheel Me
Hornishon
Leader Bass
Solitaire Four
Step Lead

Verbe Sol

Pads
Analog Orchestra
Delay Nation
Hi Sweep Ensemble
JP NL
Relax Max
Saw Ensemble
Serenity
Solina Phase
String Melody
Thorus Line

Pluck
A Class Pluck
Combo 80s
Hook Short
Hot Corn 1
Hot Corn 2
Pluck Step
Wobble Pluck

Polysynth
Melody Step
Octaved
Plucksound
Portax Moon
Stringsteps

http://www.uvi.net/


11

SATURN-4 - Layer Program List

OSC-1
Sawtooth
Square
Square + PW
Sub
Noise

OSC-2
BASS
STRING
FUNKY CLAVI
PIANO
VOICE
TROMBONE
SAX
TRUMPET
SYNTH
THE FORCE
Compu-Preset 1

Compu-Preset 2
Compu-Preset 3
Compu-Preset 4
Compu-Preset 5
Compu-Preset 6
Compu-Preset 7
Compu-Preset 8

http://www.uvi.net/
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SATURN-6 - Main Page and Globals

OSCs

Filter

5

7

Amplitude6

Balance4

Edit Layer 3

Master Volume 2

Pages 1

1  Pages
» Main, Edit, Modulation, Effects and 

 Arpeggiators

Click to change the current control page

2  Master Volume

3  Edit Layer
» Select: OSC-1 / OSC-2 / 1+2

Select OSC-1, OSC-2 or both (1+2) ; 

presents discrete Signal, Unison, Amp 

Env, Filter and Filter Env controls

» Unison

Enables genuine hardware unison per 

layer

4  Balance
Sets the balance between low and high 

register of the keyboard

5  OSCs (OSC-1 / OSC-2)
» Power

Turn OSC-1 and OSC-2 layer on/off

» Volume

Adjust the selected OSC’s volume

» Pan

Adjust the selected OSC’s pan

» Sounds

Select the OSC sound program

6  Amplitude
» Amplitude: Velocity

Toggle velocity on/off

» Amplitude: Vel > Atk

When active, routes Velocity input to 

Amp Env: Attack

» Amplitude: ADSR

Adjust the amplitude using a typical 

Attack, Decay, Sustain, Release envelope

7  Filter
» Mode

Select between LP, BP or HP filter 

shapes, or OFF to disable the filter

» Frequency

Set the filter cutoff frequency

» Resonance

Set the filter resonance amount

» Depth

Set the filter’s depth amount

» Velocity

Set the filter’s velocity sensitivity

» ADSR

Typical ADSR envelope for the Filter 

Saturn-6 is outfitted with 2 layers; OSC-1 and OSC-2. Both layers have independent selection of 120 program sounds and raw waveforms, dedicated volume, 
pan, filters and envelope generators for amplitude and filter, and arpeggiators in the Arpeggiator page. Edit and Effects pages affect the summed signal of 
both layers while Modulation can be set to selectively target OSC-1 and/or OSC-2.

http://www.uvi.net/
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SATURN-6 - Edit Page

Edit Layer

Voicing

Pitch3

Stereo4

Modwheel5

1

2

1  Edit Layer
Select OSC-1, OSC-2 or both (1+2) ; 

presents discrete controls for Pitch/

Portamento, Stereo and Modwheel

2  Voicing
» Mode

Toggle between Mono and Poly voicing

» Time

Set the Glide time

» Depth

Adjust the Portamento depth

3  Pitch
» Octave

Adjust the pitch in Octaves

» Semitone

Adjust the pitch in Semitones

4  Stereo
» Mode

Off / Alternate Pan / Unison

» Spread

Change the stereo width

» Detune

Unison layer detune amount 

[Unison mode only]

» Color

Shifts color based on adjacent samples

5  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato Rate, Tremolo Rate and Filter 

Depth

http://www.uvi.net/
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SATURN-6 - Modulation Page

Step Modulator 1

1  Step Modulator
» Steps

Change the number of playable steps 

(1-16)

» Editor

Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

» Speed

Change the step duration (1/32 - 1/1)

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Average

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

» Step Modulator Target

Control the amounts of modulation to be 

applied to each or both layer’s Volume 

Amount, and Filter Depth

2  LFO
» Speed

Change the LFO Speed

» Sync

Enable/Disable LFO sync to Host Tempo

» Waveshape

Choose LFO waveshape; Sine, Triangle, 

Square or Sample & Hold

» LFO Routing

Control the amount of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

» Mode

Change the LFO retrigger mode; 

Retrigger, No Retrigger or Legato

» LFO Target

Control the amount of modulation to be 

applied to each or both layer’s Volume 

Amount, Filter and Pitch Depth

3  Modulation Targets
Set the target oscillator for the 

parameter modulation, Upper and/or 

Lower layer

Modulation Targets3

LFO2

http://www.uvi.net/
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SATURN-6 - Effects Page

1  Equalizer
» On/Off

Turn the effect on/off

» Gain Low / Mid / High

Adjust the gain boost or cut amount of 

each frequency band

» Frequency

Set the crossover frequency point of 

Low/Mid or Mid/High band

2  Drive
» On/Off

Turn the effect on/off

» Amount 

 Adjust the drive amount

3  Thorus
» On/Off

Turn the effect on/off

» Speed 

 Adjust the chorus modulation speed

» Depth 

 Adjust the chorus modulation depth

4  Ensemble
» On/Off

Turn the effect on/off

» Mode 

 Set the ensemble effect mode

» Tone 

 Adjust the brightness of the effect

» Mix 

 Adjust the effect mix amount

5  Phasor
» On/Off

Turn the effect on/off

» Speed 

 Adjust the phaser modulation speed

» Feedback 

 Adjust the phaser feedback amount

» Depth 

 Adjust the phaser modulation depth

6  Delay
» On/Off

Turn the effect on/off

» Time 

 Adjust the delay time

» Feedback 

 Adjust the delay feedback amount

» LoCut 

 Adjust the delay output’s low-cut filter  

 frequency

» HiCut 

 Adjust the delay output’s hi-cut filter   

 frequency

» Mix 

 Adjust the delay effect mix amount

7  Sparkverb
» On/Off

Turn the effect on/off

» Size 

 Adjust the reverb room size

» Decay 

 Adjust the reverb decay time

» Decay: Lo Freq 

 Multiplies the decay time (-/+) for the  

 low frequency signal

» Decay: Hi Freq 

 Multiplies the decay time (-/+) for the  

 high frequency signal

» Mix 

 Adjust the reverb mix amount

Equalizer 1

Phaser 5

Thorus 3

Sparkverb 7

Delay6

Ensemble4

Drive2

http://www.uvi.net/
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SATURN-6 - Arpeggiator Page

Steps

Link

Speed

Arp On/Off

Gate

Octave

Mode

Step Indicator4

Step Editor5

Tie6

9

10

2

7

3

8

1

1  Power
Toggle the Arpeggiator On/Off

2  Mode
Select Up, Down, or Up and Down

3  Link
Switch to link the arpeggiators

4  Step Indicator
LED lights up when step is triggered

5  Step Editor
Freely draw note velocities

6  Tie
When active, step inherits Velocity from 

the previous step

7  Steps
Change the number of playable steps 

(1-16)

8  Speed
Change the step duration (1/32 - 1/1)

9  Gate
Change the step length (from zero to the 

tracks Resolution setting)

10  Octave
Set the pitch range in Octaves

http://www.uvi.net/
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SATURN-6 - Preset List

00-S6 Init Mono
00-S6 Init Real Unison
00-S6 Init Stereo

01-Saturn 6 Basics
S6 Bass Mono Mode
S6 Bass Poly
S6 Bass Stereo Unison
S6 Bells-Pluck Alt
S6 Bells-Pluck Stereo
S6 Brass-Poly Mono
S6 Brass-Poly Stereo
S6 Lead Mono Mode
S6 Lead Stereo
S6 Organ Mono
S6 Organ Stereo
S6 Pad-Strings Mono
S6 Pad-Strings Stereo
S6 Pad-Strings Uni Gate
S6 Piano Keys Alt
S6 Piano Keys Stereo

Animated Arp
App Wheel
Arp Noise Snare 1
Arp Noise Snare 2
Bell Arpa
Contrast Pot
Fasting
Kick Seq FX
Micro Particules
More Order
New Waves
Nouvel An
Porta Crystal
Saturn Arp 1
Saturn Arp 2
Saturn Arp 3
Saturn Arp 4
Simplicity
Space Club
Sparkle Wine
Thorused

Animated Step
Beautiful Noise
Door Unison 1
Door Unison 2
Eighties Hook
Lunar Wind
Molasonne
Money Money
Spetral Side Chain
Step Buy Steps
Voyetra Six
You Nisson

Bass
Giga Fonk
Hyper Phat 1
Hyper Phat 2
Modular Bass 1
Modular Bass 2
Modular Bass 3
Monster Bass
Obese Dual
Portoubass
Power Five 1
Power Five 2
S6 Bass Seq 1
S6 Bass Seq 2
S6 Bass Seq 3
S6 Bass Seq 4
S6 Bass Seq 5
Stereo One
Stereo Two
Sub Zarbe
Sweephat
Talking Bass
Trap Wheel Me
Triple Bass
Weirdo Gan

Bells
Best JP Bells
Digit Alike
Good Morning
Lil Whistle
Machinery
Metal Blowing
Periscope
Resonance
Shout Bells 1
Shout Bells 2
Six Bells
So Basic
Soft Trem
Space Bubbles
Step Delish
Strings Combo
Synthetic
Thin Syn Bells
Typicanalog
Windy Xmas

Brass
Classic JP Brass
Double Brass
Funk You
Large Brass
Melody Brass 1
Melody Brass 2
Melody Brass 3
OBservation
Six Brass 1
Six Brass 2
Unison Mood
Wheel Stacc

FX
Dual Stereo FX
Electro Kitchen
FX Drome
Lazer Mania
Metal Feedback
Monster Cave
Moskitos
Open Space
Saturn Winds
Space Cop
Square FX

Keys
Ample Keys
Big Keys
D2R2 Dream
Intense Piano
Klax Vinet
Piano Dark
S6 Clav
Saturn Tines 1
Saturn Tines 2
Space Wurly
Square Lil Piano
Standard Clav
Synkeys
Toy Keyboard 1
Toy Keyboard 2
Very Soft Keys
Wurlysizer

Leads
Amp Feedback
Duke Dude
Fab Five Furry 1
Fab Five Furry 2
Funky Mood
FX Brassy 1
FX Brassy 2
La Danse Des Canards
Mac Flury
Moellead
P Funk Power
Power Shaft
Psychadelay
Pulse Matic
S6 Saw Lead
Solo Tik
Square Verb
Step On Wheel
Stereo Triangles
Synth Whistle
Wave Performer
Wheel Radical

Organ
Dirty Caroussel
Full Hamm Erde
FX Manege
Key Click Organ
Le Caroussel
Organ Clickos
Phasor Gan
Rock Hard
Space Tutti

Pads
Amiral Boat
Cloud Server
HB Pad HH
Interferences
Joliness
Octav Gustav
Real Unison
Saw Pad
Sweep Franc
Vox Ethereal
Wheel Cinetic

Pluck
Da Pluck
FX Brass Pluck
Happy Harry
Malletophone
Mute Synth
Pluckgiator 1
Pluckgiator 2
Poly Short
Softhorus
Steady Attack
Uni Pluck

Polysynth
Boss Synth
Hybrid Synthesizer
Mega Funk
Multiplex
New 80s Wave
Polo Reggan
Polydoor
Porta Thin
Soft Five 1
Soft Five 2
Super Synth
Thriller
Tron Of Tree
Ultra Saw
Vocalish
Waveforms

Strings
Eminence
Large Phaser
PWMania
S6 Med Strings
String Machina
Thorustrings
Ultra HP 1
Ultra HP 2
Yanni Ensemble

http://www.uvi.net/
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SATURN-6 - Layer Program List

Bass
Classic One
EBassnalog
Fifth Bass
Filter Bass
S6ynth Bass
Talking Bass
Xtra Bass 1
Xtra Bass 2

Brass
Classic Brass 1

Classic Brass 2
Fast Horns 1
Fast Horns 2
Filter Down
Power Synth
Red Mood
Steady Brass
Sweeping 1
Sweeping 2
 

FX
Allolaterre
D2RS6
Droid Female
Impact Robot
Jupiter Winds
Lazer Long
LFO Pitch
Merci Gales
Metal Bend
Open SAS
Ramp Dom Up
Rise Up Down
Sonar Yourself
Space Feedback

Keys
Analog Piano
EPiano
Hybrid Keys
Lil Clav
Medium Clav
Road Attack
 

Leads
Fluted
Harmonica
Nasalead

Rez Solo
Soft Picolo
Solonalog
Synth Whistle
Thin Synth

Organ
Caroussaturn
Church Pipes
Gospel Day
Jazz Man
 

Pads-Strings
Glass Rev
LFO Pad
S6 Hi Strings
S6 Low Strings
S6 Med Strings
Standard Pad

Pluck-Bells
Cool Bells
Good4Pluck
HPF Bells 1
HPF Bells 2
Lil Bells
LPF Bells
Rezo Pluck
S6 Bells
S6 Cool Pluck 1
S6 Cool Pluck 2
So Pluck

Tremo Bells
Triangle Pluck

Polysynth
Noise Stab
Polil Square
Power Sync
Pure Poly

Waveform Basic
Noise
PW 025 2
PW 025 4
PW 025 8
PW 025 16
PW 025 32
PW 050 2
PW 050 4
PW 050 8
PW 050 16
PW 050 32

PW 075 2
PW 075 4
PW 075 8
PW 075 16
PW 075 32
PW 100 2
PW 100 4
PW 100 8
PW 100 16
PW 100 32
Saw 2
Saw 4
Saw 8
Saw 16
Saw 32
Square 2
Square 4
Square 8
Square 16
Square 32
Triangle 2
Triangle 4
Triangle 8
Triangle 16
Triangle 32

Waveform Bonus
Double Saw 2
Double Saw 4
Double Saw 8
Double Saw 16
Double Saw 32
Double Triangle 2
Double Triangle 4
Double Triangle 8
Double Triangle 16
Double Triangle 32
Square Pulse 100 2

Square Pulse 100 4
Square Pulse 100 8
Square Pulse 100 16
Square Pulse 100 32
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SATURN-8 - Main Page and Globals

Layers

Filter

5

7

Amplitude6

Balance4

Edit Layer 3

Master Volume 2

Pages 1

1  Pages
» Main, Edit, Modulation, Effects and 

 Arpeggiators

Click to change the current control page

2  Master Volume

3  Edit Layer
» Select: OSC-1 / OSC-2 / 1+2

Select OSC-1, OSC-2 or both (1+2) ; 

presents discrete Signal, Unison, Amp 

Env, Filter and Filter Env controls

» Unison

Enables genuine hardware unison per 

layer

4  Balance
Sets the balance between low and high 

register of the keyboard

5  OSCs (OSC-1 / OSC-2)
» Power

Turn OSC-1 and OSC-2 layer on/off

» Volume

Adjust the selected OSC’s volume

» Pan

Adjust the selected OSC’s pan

» Sounds

Select the OSC sound program

6  Amplitude
» Amplitude: Velocity

Toggle velocity on/off

» Amplitude: Vel > Atk

When active, routes Velocity input to 

Amp Env: Attack

» Amplitude: ADSR

Adjust the amplitude using a typical 

Attack, Decay, Sustain, Release envelope

7  Filter
» Mode

Select between LP, BP or HP filter 

shapes, or OFF to disable the filter

» Frequency

Set the filter cutoff frequency

» Resonance

Set the filter resonance amount

» Depth

Set the filter’s depth amount

» Velocity

Set the filter’s velocity sensitivity

» ADSR

Typical ADSR envelope for the Filter 

Saturn-8 is outfitted with 2 layers; OSC-1 and OSC-2 Both layers have independent selection of 133 sounds, dedicated volume, pan, filters and envelope 
generators for amplitude and filter, and arpeggiators in the Arpeggiator page. Edit and Effects pages affect the summed signal of both layers while Modulation 
can be set to selectively target OSC-1 and/or OSC-2.
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SATURN-8 - Edit Page

Edit Layer

Voicing

Pitch3

Stereo4

Modwheel5

1

2

1  Edit Layer
Select OSC-1, OSC-2 or both (1+2) ; 

presents discrete controls for Pitch/

Portamento, Stereo and Modwheel

2  Voicing
» Mode

Toggle between Mono and Poly voicing

» Time

Set the Glide time

» Depth

Adjust the Portamento depth

3  Pitch
» Octave

Adjust the pitch in Octaves

» Semitone

Adjust the pitch in Semitones

4  Stereo
» Mode

Off / Alternate Pan / Unison

» Spread

Change the stereo width

» Detune

Unison layer detune amount 

[Unison mode only]

» Color

Shifts color based on adjacent samples

5  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato Rate, Tremolo Rate and Filter 

Depth

http://www.uvi.net/
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SATURN-8 - Modulation Page

Step Modulator 1

1  Step Modulator
» Steps

Change the number of playable steps 

(1-16)

» Editor

Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

» Speed

Change the step duration (1/32 - 1/1)

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Average

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

» Step Modulator Target

Control the amounts of modulation to be 

applied to each or both layer’s Volume 

Amount, and Filter Depth

2  LFO
» Speed

Change the LFO Speed

» Sync

Enable/Disable LFO sync to Host Tempo

» Waveshape

Choose LFO waveshape; Sine, Triangle, 

Square or Sample & Hold

» LFO Routing

Control the amount of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

» Mode

Change the LFO retrigger mode; 

Retrigger, No Retrigger or Legato

» LFO Target

Control the amount of modulation to be 

applied to each or both layer’s Volume 

Amount, Filter and Pitch Depth

3  Modulation Targets
Set the target oscillator for the 

parameter modulation, Upper and/or 

Lower layer

Modulation Targets3

LFO2
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SATURN-8 - Effects Page

1  Equalizer
» On/Off

Turn the effect on/off

» Gain Low / Mid / High

Adjust the gain boost or cut amount of 

each frequency band

» Frequency

Set the crossover frequency point of 

Low/Mid or Mid/High band

2  Drive
» On/Off

Turn the effect on/off

» Amount 

 Adjust the drive amount

3  Thorus
» On/Off

Turn the effect on/off

» Speed 

 Adjust the chorus modulation speed

» Depth 

 Adjust the chorus modulation depth

4  Ensemble
» On/Off

Turn the effect on/off

» Mode 

 Set the ensemble effect mode

» Tone 

 Adjust the brightness of the effect

» Mix 

 Adjust the effect mix amount

5  Phasor
» On/Off

Turn the effect on/off

» Speed 

 Adjust the phaser modulation speed

» Feedback 

 Adjust the phaser feedback amount

» Depth 

 Adjust the phaser modulation depth

6  Delay
» On/Off

Turn the effect on/off

» Time 

 Adjust the delay time

» Feedback 

 Adjust the delay feedback amount

» LoCut 

 Adjust the delay output’s low-cut filter  

 frequency

» HiCut 

 Adjust the delay output’s hi-cut filter   

 frequency

» Mix 

 Adjust the delay effect mix amount

7  Sparkverb
» On/Off

Turn the effect on/off

» Size 

 Adjust the reverb room size

» Decay 

 Adjust the reverb decay time

» Decay: Lo Freq 

 Multiplies the decay time (-/+) for the  

 low frequency signal

» Decay: Hi Freq 

 Multiplies the decay time (-/+) for the  

 high frequency signal

» Mix 

 Adjust the reverb mix amount

Equalizer 1

Phaser 5

Thorus 3

Sparkverb 7

Delay6

Ensemble4

Drive2
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SATURN-8 - Arpeggiator Page

Steps

Link

Speed

Arp On/Off

Gate

Octave

Mode

Step Indicator4

Step Editor5

Tie6

9

10

2

7

3

8

1

1  Power
Toggle the Arpeggiator On/Off

2  Mode
Select Up, Down, or Up and Down

3  Link
Switch to link the arpeggiators

4  Step Indicator
LED lights up when step is triggered

5  Step Editor
Freely draw note velocities

6  Tie
When active, step inherits Velocity from 

the previous step

7  Steps
Change the number of playable steps 

(1-16)

8  Speed
Change the step duration (1/32 - 1/1)

9  Gate
Change the step length (from zero to the 

tracks Resolution setting)

10  Octave
Set the pitch range in Octaves
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SATURN-8 - Preset List

00-S8 Init Mono
00-S8 Init Real Unison
00-S8 Init Unison

01-Saturn 8 Basics
S8 Bass Mono Mode
S8 Bass Poly
S8 Bass Unison
S8 Bells-Pluck Alt
S8 Bells-Pluck Stereo
S8 Brass-Poly Mono
S8 Brass-Poly Stereo
S8 Lead Mono Mode
S8 Lead Stereo
S8 Organ Mono
S8 Organ Stereo
S8 Pad-Strings Mono
S8 Pad-Strings Stereo
S8 Pad-Strings Uni Gate
S8 Piano-Keys Alt
S8 Piano-Keys Stereo

Animated Arp
A Little Story
Animated Saturn
Arp JP Dream 1
Arp JP Dream 2
Arp JP Dream 3
Dual Spectre 1
Dual Spectre 2
Dual Spectre 3
First Light
Less Is More
One Two
S8 Arp Double 1
S8 Arp Double 2
S8 Arp Double 3
S8 Arp Double 4
Saturnin
Smooth Arpeggiator
SPA Lounge
String Mr Synth
Thorused
Tribal Sub
Underwater Pop Corn
Wet Sines
Wheel TBish

Animated Step
Amiral Boat 1
Amiral Boat 2
Basic Gate
Canada Dry
Combination Plate
Happy Meal
Keys Step
No Rez
Peter Brass Gate
Powerbank
Sad Guru
Side Chaining
Simple Step
Soft Gate
Starstep War
Step Sync Osc
Tremo Basic
Underwater
Wheel Parasite
Wheel Passion 1
Wheel Passion 2

Bass
Analogie
Auto Bass 1
Auto Bass 2
Auto Bass 3
Bambastrings
Crush JP8
Decay on Wheel
Huge Waves
Japan Taurus
Lennox Fat
Mini Phase
Mixage
Noise And Bass
Phat Mom
Pure Analog 1
Pure Analog 2
S8 Bass Seq 1
S8 Bass Seq 2
S8 Bass Seq 3
S8 Bass Seq 4
Smooth TB
Squarobot
Sub Way
Trash Dist
Unison Star
Vibra Lows
Wheel Shaft

Bells
Digital Bells
Gentle Soft
Haribells
Ice Land
Jolie Reales
Jupiter Bells
KK Wet
Krispy Kream 1
Krispy Kream 2
Luminou
Metalholic
No Attack
Parasite Express
Phasor Bells
Pizzi Bella
Quinte Brass
Synthetique
Tesla Bella
Tiny Island
Train Mellow
Xmas Time 1
Xmas Time 2

Brass
Chariott Fire
Dual Brass
Dual Unison
King Entrance
Mystic Horns 1
Mystic Horns 2
OB Style
Playfull Stacs
Power Brass 1
Power Brass 2
Royal O Bar
Short Hit
Spacial Horns

Chords
Dual Shock
Eight Dimension
Fifth Planet
Madonnish 1
Madonnish 2
Power Bass
S8 Power

FX
Almost Pad
Analog Mayhem
Crowd Bubbles
Fire Higher
Frantic Church
Gomme Bubble
Grand Sweep
Mad Scientist
Sweep Monsters
Zobilla Space

Keys
Analog Clikeys
CP JP 70
Dynomic
Gorgeous Keys
Harps In Churcj
Jupiter Me
Lil Keys Vox
Power Clav 1
Power Clav 2
Power Clav 3
Scissors Keys
Sombre Piano
Space Harpsichord
Stack Keys
Synth Tines

Leads
Dual Lead
Dual Octave Sync
Funk Trish
Hello George
Karalead
Lead Bass 1
Lead Bass 2
Mayfilead
Mono Me
Montreal Dry
New Age
Scie Vox
Smoothie
Solo Percs
Stereo Mono
Stereoctave
Sub Lead
Sunglasses
Sync Her View
Ultra Funk 1
Ultra Funk 2

Organ
Attack Me
Davincible
Full Standard
Hybrid Ensemble
Klikoss
Little Park
Ma Paroisse
Small Pipes
Synth Organ
Very High

Pads
Aristopad
Detoxygen
Drone Vibration
Dual Waves Pad
Filter on Wheel
Grand Canyon
Intensity
LA Beauty
Lunar Dune
Moonlight
Moov Mood
North Pole
Over Pad
Passpartoo 1
Passpartoo 2
Phaser Mania
Picth Instable
Play Velocity
Reflection
Sine Nature
Spectral Split
Sweep On Wheel
Voice Up
Vox Mood
Wet Cavern

Pluck
Analog Pluck
Caraibe Feel
Coton Stab
Dirty Delay
Fat Pluck
Guitaflute
Little Resonance
Pluck O Lead
Smooth Pluck
Steel Drums
Stratospace
Synth Acc Guitar
Wheel Attack Flute

Polysynth
Class A Mix
Clic Flute
Funky Dirty
Hybrid Pluck
King Bed
Polysync 1
Polysync 2
Pure Saws
Stabubbles
Stackoptere
Wheel Funk

Strings
Expressive
Hall Of Strings
Jet Strings
Large Orchestra
LFO Strings
Mix Bellish
Octave Ensemble
Opering
Orchestrash
Phasorchestra
Phat Mello
Space Archet
Strings FX
Synth Violin
Unperfect
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SATURN-8 - Layer Program List

Bass
Double Bass
JP8 Bass
Patch Bass
Pedal Organ
Phat House
Retro Square
Sub Organ
 

Brass
Blip Brass
Brass High

Brass Low
Evolver
High Fast
Jupower 8
Porta Double
Rez Brass
Synth Brass 1
Synth Brass 2
 

Chords
Brass Fifth
Five Fuzz
Four My Hommies
JP Fourth
Phat 5 Freddy
Power 5
Tritone
 

FX
Del Board
Delayed
Fire Drop
Gum Bubbles
Invasion
La Piedra
Low Perc
Motor On
Native Seq
Nawak Door
Old Horns

Pigs In Space
Space Gong
Start Engine
Sweep Wind
Voxish
 

Keys
Cheezy Keys
Harpsi 8
Harpsichord
Hybrid Road
JP Clav
Mellow EP
Pianotic
Pure Tines Rel
Pure Tines
Wurly
 

Leads
Drastic Solo
EmBrassad
Flutish
Funky Detune
Hamm Lead
Huge Sync
Little Sad
Noise Flute
Solo Duke
Square Clari
Synth Accordion

Typical Sync
Whistle
 

Organ
Attack Organ
Barbarian
Comb Organ
Ham Cool
Hammish
Mellow Organ
Pipes
 

Pads
Beauty Pad
Blip Pad
Choirish
Filtered Organ
Fixed LFO
Lil Vox
Moving High
Ominous JP
Rythm FX Pad
Say Bo
Space Church
Swell Quant
Typical J
Warmer
Wonder Brite
 

Pluck & Bells
Chime
FX Chimes
Frantic Tack
Harm Perc
Honky Pluck
Industry Bells
JPluck
Material Girl
Multiplia
Organ Bells II
Organ Bells

Pluck Me
Xylo Bell
Yella Bella
 

Polysynth
JPhonk
JPoly Synth
Mello Harmo
Pitchenv
Polhybrid
Power J
 

Strings
LFO Strings
Raw Strings
Slow High
Strings High
Strings Low
Strings Medium
Synth Cello
Synth Violin
 

Waveform Basic
Noise
Saw 2
Saw 4
Saw 8
Saw 16
Sine 2
Sine 4
Sine 8
Sine 16
Square 2
Square 4

Square 8
Square 16
Triangle 2
Triangle 4
Triangle 8
Triangle 16
 

Waveform PWM
PWM 025 2
PWM 025 4
PWM 025 8
PWM 025 16
PWM 050 2
PWM 050 4
PWM 050 8
PWM 050 16
PWM 075 2
PWM 075 4
PWM 075 8
PWM 075 16
PWM 100 2
PWM 100 4
PWM 100 8
PWM 100 16
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MERCURY-80 - Main Page and Globals

Layers

Filter

5

7

Amplitude6

Balance4

Edit Layer 3

Master Volume 2

Pages 1

1  Pages
» Main, Edit, Modulation, Effects and 

 Arpeggiators

Click to change the current control page

2  Master Volume

3  Edit Layer
» Select: OSC-1 / OSC-2 / 1+2

Select OSC-1, OSC-2 or both (1+2) ; 

presents discrete Signal, Unison, Amp 

Env, Filter and Filter Env controls

» Unison

Enables genuine hardware unison per 

layer

4  Balance
Sets the balance between low and high 

register of the keyboard

5  OSCs (OSC-1 / OSC-2)
» Power

Turn OSC-1 and OSC-2 layer on/off

» Volume

Adjust the selected OSC’s volume

» Pan

Adjust the selected OSC’s pan

» Sounds

Select the OSC sound program

6  Amplitude
» Amplitude: Velocity

Toggle velocity on/off

» Amplitude: Vel > Atk

When active, routes Velocity input to 

Amp Env: Attack

» Amplitude: ADSR

Adjust the amplitude using a typical 

Attack, Decay, Sustain, Release envelope

7  Filter
» Mode

Select between LP, BP or HP filter 

shapes, or OFF to disable the filter

» Frequency

Set the filter cutoff frequency

» Resonance

Set the filter resonance amount

» Depth

Set the filter’s depth amount

» Velocity

Set the filter’s velocity sensitivity

» ADSR

Typical ADSR envelope for the Filter 

Mercury-80 is outfitted with 2 layers; OSC-1 and OSC-2. Both layers have independent selection of 105 OSC sounds, dedicated volume, pan, filters and 
envelope generators for amplitude and filter, and arpeggiators in the Arpeggiator page. Edit and Effects pages affect the summed signal of both layers while 
Modulation can be set to selectively target upper and/or lower.
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MERCURY-80 - Edit Page

Edit Layer

Voicing

Pitch3

Stereo4

Modwheel5

1

2

1  Edit Layer
Select OSC-1, OSC-2 or both (1+2) ; 

presents discrete controls for Pitch/

Portamento, Stereo and Modwheel

2  Voicing
» Mode

Toggle between Mono and Poly voicing

» Time

Set the Glide time

» Depth

Adjust the Portamento depth

3  Pitch
» Octave

Adjust the pitch in Octaves

» Semitone

Adjust the pitch in Semitones

4  Stereo
» Mode

Off / Alternate Pan / Unison

» Spread

Change the stereo width

» Detune

Unison layer detune amount 

[Unison mode only]

» Color

Shifts color based on adjacent samples

5  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato Rate, Tremolo Rate and Filter 

Depth
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MERCURY-80 - Modulation Page

Step Modulator 1

1  Step Modulator
» Steps

Change the number of playable steps 

(1-16)

» Editor

Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

» Speed

Change the step duration (1/32 - 1/1)

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Average

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

» Step Modulator Target

Control the amounts of modulation to be 

applied to each or both layer’s Volume 

Amount, and Filter Depth

2  LFO
» Speed

Change the LFO Speed

» Sync

Enable/Disable LFO sync to Host Tempo

» Waveshape

Choose LFO waveshape; Sine, Triangle, 

Square or Sample & Hold

» LFO Routing

Control the amount of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

» Mode

Change the LFO retrigger mode; 

Retrigger, No Retrigger or Legato

» LFO Target

Control the amount of modulation to be 

applied to each or both layer’s Volume 

Amount, Filter and Pitch Depth

3  Modulation Targets
Set the target oscillator for the 

parameter modulation, Upper and/or 

Lower layer

Modulation Targets3

LFO2
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MERCURY-80 - Effects Page

1  Equalizer
» On/Off

Turn the effect on/off

» Gain Low / Mid / High

Adjust the gain boost or cut amount of 

each frequency band

» Frequency

Set the crossover frequency point of 

Low/Mid or Mid/High band

2  Drive
» On/Off

Turn the effect on/off

» Amount 

 Adjust the drive amount

3  Thorus
» On/Off

Turn the effect on/off

» Speed 

 Adjust the chorus modulation speed

» Depth 

 Adjust the chorus modulation depth

4  Ensemble
» On/Off

Turn the effect on/off

» Mode 

 Set the ensemble effect mode

» Tone 

 Adjust the brightness of the effect

» Mix 

 Adjust the effect mix amount

5  Phasor
» On/Off

Turn the effect on/off

» Speed 

 Adjust the phaser modulation speed

» Feedback 

 Adjust the phaser feedback amount

» Depth 

 Adjust the phaser modulation depth

6  Delay
» On/Off

Turn the effect on/off

» Time 

 Adjust the delay time

» Feedback 

 Adjust the delay feedback amount

» LoCut 

 Adjust the delay output’s low-cut filter  

 frequency

» HiCut 

 Adjust the delay output’s hi-cut filter   

 frequency

» Mix 

 Adjust the delay effect mix amount

7  Sparkverb
» On/Off

Turn the effect on/off

» Size 

 Adjust the reverb room size

» Decay 

 Adjust the reverb decay time

» Decay: Lo Freq 

 Multiplies the decay time (-/+) for the  

 low frequency signal

» Decay: Hi Freq 

 Multiplies the decay time (-/+) for the  

 high frequency signal

» Mix 

 Adjust the reverb mix amount

Equalizer 1

Phaser 5

Thorus 3

Sparkverb 7

Delay6

Ensemble4

Drive2
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MERCURY-80 - Arpeggiator Page

Mode

Link

Octave

Arp On/Off

Gate

Speed

Steps

Step Indicator4

Step Editor5

Tie6

9

8

7

2

3

10

1

1  Power
Toggle the Arpeggiator On/Off

2  Mode
Select Up, Down, or Up and Down

3  Link
Switch to link the arpeggiators

4  Step Indicator
LED lights up when step is triggered

5  Step Editor
Freely draw note velocities

6  Tie
When active, step inherits Velocity from 

the previous step

7  Steps
Change the number of playable steps 

(1-16)

8  Speed
Change the step duration (1/32 - 1/1)

9  Gate
Change the step length (from zero to the 

tracks Resolution setting)

10  Octave
Set the pitch range in Octaves
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MERCURY-80 - Preset List

00-M80 Init Mono
00-M80 Real Unison
00-M80 Unison

01 Mercury-80 Basics
M80 Bass Mono Mode
M80 Bass Poly
M80 Bass Stereo
M80 Bells-Pluck Alt
M80 Bells-Pluck Stereo
M80 Brass-Poly Mono
M80 Brass-Poly Stereo
M80 Lead Mono Mode
M80 Lead Stereo
M80 Organ Mono
M80 Organ Stereo
M80 Pad-Strings Mono
M80 Pad-Strings Stereo
M80 Pad-Strings Uni Gate
M80 Piano-Keys Alt
M80 Piano-Keys Stereo

Animated Arp
Arpower Synth
Dream Tanger
Fiesta Verde
Flamingo
Give Me Five
Hollistique
Magic Horse
Margarita
Mercure O Chrome
Mono Spiral
Moog Lee
Noise Module
Nuage
Origami
Pad Arp Malgam
Phase Two
PMW n Bass
Pole Sud
Robin Hey
Sine Compromise
So Simple 1
So Simple 2
Square Club
Wet Bedroom
Wheel Distox
Wheel Expression
Wheel To Attack

Animated Step
Explorator
Fall Step Arp
Inside Chain
LFO Square
Mahyem of Steps
Melody Bass 1
Melody Bass 2
Pure Step
Rouille Synth
Square Fest
Tube Blow
Wheel Classic
Wheel Me

Bass
Bass MKSeq 1
Bass MKSeq 2
Bass MKSeq 3
Bass MKSeq 4
Bass MKSeq 5
Clav Bass
Dirty One
JPhat Ana Bass
Low Analog 1
Low Analog 2
Mix Bass 1
Mix Bass 2
Obez Hand
Rubber Bass
Steady Bass
Syntuba
Tribalism
Wheel Grain

Bells
Bellissima
Creative
Darling Sine
Harp Mood
Hybrid Click
Hyperbellic
Lil Portamento 1
Lil Portamento 2
MKS Bells
Pastel Bells
Pulsar Bells
Simple Square 1
Simple Square 2
Tek Oktav
Thalasso
Toy Pianoish
Tubular 1
Tubular 2
Wheel Step Bells
Xmas Tree
Yanni Bells

Brass
Elephant Horns
Metal Trumpet
Mix City 1
Mix City 2
Phase Low
Phonk Brass
Pop Synth
Pride Horns
Slow Brasses 1
Slow Brasses 2
Stab Island
Synth Brass
Tremorchestral
Trumpets
War Ensemble

FX
Analog Ambience
Gargouilles
Heart Bytes
Lunar Provence
Machine A Laver
MKavern 80
Pac Mod
Wet D2R2

Keys
Acoustic Keys
Darklavinet
Funk Lave
Hybrid Clav Keys
Key Shafting
Phase Clav
Pluckeys
Plucklav
Power Keys
Road Trip
Wurly CP
Wurly Real Unison

Leads
Dualead 1
Dualead 2
Dualead 3
Funk Piccolo
Hammond A Lead
Hybrid Happy
Joy
Leader Brass
Leader Five
MKS Funk
Noisolo
Petit Solo
PWM Delay
Space Big Blue
Spetralead
Trompetino
Wheel Mayhem
Whistle Mania

Organ
Hybrid Vel
Jazzy Perc
Lemon Air
Moran Morgan
Smooth Organ

Pads
Analog King
Beauty Mercury
Crystal Bed
Dual Spectrum
High And Low
Massive Sparkles
More Than Large
Pad Bell X
Phase Particules
Pulsar Step
Slowminous
Tabernak
Time Long
Vanilla Caster
Voice N Birds
Wheel Vel Move
Zen Zone

Pluck
Cool Pluck
Dark Pluck
Harpluck 1
Harpluck 2
Hybrid Balaf
LFO Noise Sweep
Mallet Char
Mute Able
Nostalgie
Octavia
Pluck Me
Pop Korn
Room Service
Skinny Fat
Smooth Pluck 1
Smooth Pluck 2
So 80s
Stab Pluck 1
Stab Pluck 2
Steely Drums
Wet Pluck

Polysynth
Eighties Folies
Evolver Poly
Flutty Belly Arp
Funky Fwesh
LPhonic
Phat Funk
Phonkarpeggio
Poly Dulce
Portriangle
Power Synth 1
Power Synth 2
Saw Noise
Six Saw
Square Flutish
Tyler Bone
Vox Attack

Strings
Analog Strings
Hammond Church
Play Staccato
Smooth Hit
Sol Inox
Space Orchestra
Synth Pizz
TeeVee Strings
Ultra HP
Unknown Strings

Sweeps
Delay N Sweep
Reverse On Wheel
Rough Sweep
Stack Mix
Tremosweep
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MERCURY-80 - Layer Program List

Bass
Double Bass
Electric Bass
JPhat Ana Bass
Steady Bass
 

Bells
Hyperbellic
Jupibells
MKS Bells I
MKS Bells II
Noisalafon

Steely Drums
Synth Xylo
Toy Bells
Tubular
 

Brass
Hyper Brass
MKSynth Brass
Phonk Brass
Pop Synth
Slow Brass I
Slow Brass II
Squeezy Brass
Sync Brass
Synth Brass
 

Keys
Harspsichord
Hybrid Clav
Jazzy Organ
Klavanalog
MClavS 80
Mercury EPiano
Moran Morgan
Power Clav
Power Keys
Road Trip
Smooth Organ

Synth Harp
Wurlish
 

Leads
Hyper Lead
Jupiter 5
Magalead
Petit Solo
Power Lead
Smooth Lead
Solo Mio
Synth Lead
Trumpet
 

Pads & Strings
Analog Strings
Horror Pad
JP Sines
Mellorchestra
Power Pad
Pulsar One
Slowminous
Uni Voice
 

Pluck
Attack 80

Attack 90
Guitarish
Mute Able
Pop MKS Corn
Smooth Pluck
Typical Pluck
 

Polysynth
Bright Synth
Evolver Poly
Funky Town
Lauper Synth
Poly Attack
Polysynth
Power Synth
Sehr Detuned
Standard Synth
Steady Synth
 

Waveform Basic
Noise
Saw 2
Saw 4
Saw 8
Saw 16
Saw 32
Square 2
Square 4
Square 8
Square 16
Square 32

Triangle 2
Triangle 4
Triangle 8
Triangle 16
Triangle 32
 

Waveform PWM
PWM 025 2
PWM 025 4
PWM 025 8
PWM 025 16
PWM 025 32
PWM 050 2
PWM 050 4
PWM 050 8
PWM 050 16
PWM 050 32
PWM 075 2
PWM 075 4
PWM 075 8
PWM 075 16
PWM 075 32
PWM 100 2
PWM 100 4
PWM 100 8
PWM 100 16
PWM 100 32

http://www.uvi.net/
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Links

UVI

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/ 

UVI Portal .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  uvi.net/uvi-portal 

Soundbank Installation Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . installing_uvi_soundbanks_en.pdf 

UVI Workstation User Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uviworkstation_user_guide_en.pdf 

Your Registered Product Serial Numbers and Download Links.  .  .  .  .  .  .  .  .  uvi.net/my-products 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/faq 

Tutorial and Demo Videos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . youtube.com/

Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/contact-support 

iLok

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ 

iLok License Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ilm.html 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/supportfaq 

http://www.uvi.net/
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https://www.uvi.net/uvi-portal.html
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http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/my-products
http://www.uvi.net/faq
https://www.youtube.com/user/UVIofficial
http://www.uvi.net/contact-support
http://www.ilok.com/
https://www.ilok.com/#!license-manager
https://www.ilok.com/#!faq
https://www.ilok.com/#!faq
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